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Elementary Algebra - Substitution 
Evaluation of algebraic expressions through substitution 

When  and , by how much does the value of 

 exceed the value of ? 

F.                G.              H.             J.             K.  

 

http://www.actstudent.org/sampletest/math/math_01.html 

 

 

 

Type the first expression, .  
 
Press /= and choose the such that 
command (it looks like a vertical bar). 

 
Type x=3 and y=5 then press ·. 
 
Press the £  arrow on the touchpad twice to 
highlight the expression you typed in.  

 
Press ·  and edit the expression to read, 

, then press ·. 
 
Subtract the value of the second expression 
from the value of the first expression. 

 

http://www.actstudent.org/sampletest/math/math_01.html
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Pre-Algebra - Solving Linear Equations 
Solving Linear Equations in one-variable 

If , then  ? 

A.              B.               C.              D.             E.  

 

Press b>Algebra>Numerical Solve. 
 

 
Then type the equation,  
 
Now, type ,X  and press ·. 

 
Press b>Number>Approximate to Fraction,  
then press ·. 

 
 

http://media.actstudent.org/documents/preparing.pdf 

 

 

 

http://media.actstudent.org/documents/preparing.pdf
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Intermediate Algebra - Functions 
Evaluating a Function at a Value 

A function  is defined as . What is  ? 

F.            G.             H.             J.          K.  

 

Type , then press /t (this types :=) 
 

 
Then type the function,  and press ·. 

 
Type  and press ·. 

 
 

http://media.actstudent.org/documents/preparing.pdf 

 

 

 

http://media.actstudent.org/documents/preparing.pdf
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Pre-Algebra - Lowest Common Multiple 
Basic Operations Using Whole Numbers 

What is the least common multiple of  and  ? 

F.               G.            H.           J.         K.  

 

Press b>Number>Least Common Multiple. 
 

 
Then type  and press ·. 
 
 
Now, we are going to find the LCM of the 
answer you just calculated and the 3rd 
number. 

 
Press b>Number>Least Common Multiple. 
Type  and press ·. 
 

 
 

http://media.actstudent.org/documents/preparing.pdf 

 

 

 

 

http://media.actstudent.org/documents/preparing.pdf
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Intermediate Algebra - Modeling 
Find the function given a set of data 

As Part of  a lesson on motion, students observed a cart rolling at a 

constant rate along a straight line. As shown in the chart below, they 

recorded the distance,  feet, of the cart from a reference point at 

second intervals from  seconds to  seconds. 

 0 1 2 3 4 5 

 14 19 24 29 34 39 

Which of the following equations represent this data? 

F.                 G.               H.  

                    J.                   K.  

Insert a Lists & Spreadsheet page.  
 
Title the lists (in the top cell)  and . 
 
Type in the data. (Press e to navigate to the 
next cell). 
 

 
Place your cursor in column C. 
 
Press b>Statistics>Stat Calculations>Linear 
Regression (mx+b). 
 
 

 
Press · to see the results of the regression. 
 

 
http://media.actstudent.org/documents/preparing.pdf 

http://media.actstudent.org/documents/preparing.pdf
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Coordinate Geometry - Points 
Relations between equations and graphs 

The graph of  passes through  in the 

standard  coordinate plane. What is the value of ? 

F.               G.                H.               J.            K.  

Insert a Graphs page. 
 
Type  and press ·. 
 

 
Press b>Trace>Graph Trace. 
 
Type  and press ·. (This jumps the point 
to the x-value of ) 

 
Solve   
 
(Hopefully, you don’t need a calculator for this 
step). 

 
 

http://media.actstudent.org/documents/preparing.pdf 

 

 

 

http://media.actstudent.org/documents/preparing.pdf
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Coordinate Geometry - Circles 
Relations between equations and graphs 

A particular circle in the standard  coordinate plane has an 

equation of . What are the radius of the circle, in 

coordinate units, and the coordinates of the center of the circle? 

    radius center   radius center 

F.                                H.                         

G.                                        J.                      

                                                          K.                         

Insert a Graphs page. 
 
Press b>Graph Entry/Edit>Equation>Circle> 

 

 
Type  for ,  for , and  for r. 
 
Press · to graph the circle.  

 
Press b>Analyze Graph>Analyze 
Conics>radius (Click once on the circle and 
again to place the measurement. 
Press b>Analyze Graph>Analyze 
Conics>Center (click twice like before) 

Since  is approximately  , you 
have found the answer. 

 
 

http://media.actstudent.org/documents/preparing.pdf 

http://media.actstudent.org/documents/preparing.pdf
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Intermediate Algebra - System of Equations 
Graphing a system of equations 

The equations below are linear equations of a system where  and  

are positive integers.             

                                                  

Which of the following describes the graph of at least  such system of 

equations in the standard  coordinate plane? 

                        parallel lines 

             intersecting lines 

                    A single line 

A.  only            B.  only        C.  only      D.  or  only     E. , , or            

Choose values for ,  and  so that you can 
graph each equation.  
 
Let’s set ,  and  
 
Press b>Graph Entry/Edit>Equation>Line> 

 
 

Type ,  and  in the appropriate spots. 
 
Press · to graph the line.  

 
Press e to open the Entry Line. 
 
Type ,  and  in the appropriate spots. 
 
Press · to graph the line.  

 
 

http://media.actstudent.org/documents/preparing.pdf 

http://media.actstudent.org/documents/preparing.pdf
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Intermediate Algebra - System of Equations 
Solving a system of equations 

For what value of  would the following system of equations 

have an infinite number of solutions? 

     

                                    

A.               B.            C.             D.           E.  

Press b>Algebra>Solve System of Equations 
 
Click OK since the default choices are correct. 
 
 
 

 
Type the first equation, , then type 
the second equation and substitute the first 
answer choice for ,  
 
Press · to find the solution. 

 
Copy and paste the previous command by 
clicking £  on the Touchpad until the previous 
command is highlighted, press · to paste 
the command. 
Now, edit the command so that the 2nd 
answer choice is substituted for . (the c1 
indicates an infinite number of solutions) 

 
 

http://media.actstudent.org/documents/preparing.pdf 

 

http://media.actstudent.org/documents/preparing.pdf
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Intermediate Algebra - Matrices 
Finding the Determinant of a Matrix 

The determinant of a matrix  equals . What must be the 

value of  for the matrix  to have a determinant of  ? 

A.                 B.              C.               D.               E.  
 

Press b>Matrix & Vector>Determinant. 
 
Press t and choose the  matrix shown. 

 
Substitute the first answer choice for  and 

type the matrix,  

 
Press · to find the determinant of the 
matrix. 
  

 
Copy and paste the previous command by 
clicking £  on the Touchpad until the previous 
command is highlighted, press · to paste 
the command. 
Now, edit the command so that the 2nd 
answer choice is substituted for . (Repeat 
with all the answer choices) 

 
 

http://media.actstudent.org/documents/preparing.pdf 

 

 

 

  

http://media.actstudent.org/documents/preparing.pdf
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Pre-Algebra - Greatest Common Factor 
Basic Operations Using Whole Numbers 

What is the greatest common factor of  and  ? 

F.                G.                 H.               J.              K.  

Press b>Number>Greatest Common 
Divisor. 
 

 
Then type  and press ·. 
 
 
Now, we are going to find the GCF of the 
answer you just calculated and the 3rd 
number. 

 
Press b>Number>Greatest Common 
Divisor. 
 
Type  and press ·. 
 

 
 

http://www.actstudent.org/sampletest/math/math_01.html 

 

 

 

 

http://www.actstudent.org/sampletest/math/math_01.html
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Coordinate Geometry - Slope 
Finding the slope of a linear line 

What is the slope of any line parallel to the line ? 

F.                G.                 H.                J.              K.  

Press b>Graph Entry/Edit>Equation> 
Line>ax+by=c. 
 

 
Then type  in the blanks. (Use the e 
key to jump from one to the next). 
 
Press · to graph the function. 
 

 
Press b>Geometry>Measurement>Slope. 
 
Click once on the graph and click once more to 
place the slope measurement on the screen. 
 

 
 

http://www.actstudent.org/sampletest/math/math_02.html 

 

 

 

 

http://www.actstudent.org/sampletest/math/math_02.html
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Pre-Algebra - Percent 
Converting percent to decimal 

A DVD player with a list price of  is  marked down . If 

John gets an employee discount of  off the sale price, how 

much does John pay for the DVD player? 

A.         B.        C.        D.      E.  

Type  r  
 
Press /k and choose the  symbol, then 
press ·. 
 

 
Subtract the amount of the first discount from 
the original price. 

 
Repeat the process to find the total after the 
second discount. 

 
 

http://www.actstudent.org/sampletest/math/math_02.html 

 

 

http://www.actstudent.org/sampletest/math/math_02.html
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Intermediate-Algebra - Complex Numbers 
Evaluating expressions 

12.  ? 

(Note:  ) 

F.               G.             H.              J.            K.     

Change the settings in your handheld. 
Press c>Settings>Document Settings. 
 
Change Real or Complex to Rectangular.  
(This allows the handheld to produce complex 
answers). Click Make Default to change the 
scratchpad settings at the same time. 

 
Type the expression. 
Press /q to type the square root template. 

 
 

http://www.actstudent.org/sampletest/math/math_02.html 

 

 

 

 

 

 

 

 

http://www.actstudent.org/sampletest/math/math_02.html
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Coordinate Geometry - Midpoints 
Find the midpoint given two ordered pairs 

In the standard  coordinate plane, what are the 

coordinates of the midpoint of a line segment whose endpoints 

are  and  ? 

A.             B.           C.           D.          E.  

Press b>Geometry>Points & 
Lines>Segment.  
Hover over the icon in the top left corner of 
the screen and you will see the hint about 
pressing “(“ and then the coordinates to plot 
the segment. 

 
Press (, then enter the x-value, . Press 
·, then enter the y-value, .  
 
Repeat to enter the 2nd ordered pair. Press 
(, then enter the x-value, . Press ·, then 
enter the y-value, .  
 

 
Press b>Geometry>Construction>Midpoint, 
then click the segment.  
 
Use the Touchpad to hover your cursor over 
the midpoint and press /b>Coordinates 
& Equations. 

 
 

http://www.actstudent.org/sampletest/math/math_03.html 

 

 

http://www.actstudent.org/sampletest/math/math_03.html
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Pre-Algebra - Decimals 
Basic operations with decimals 

What is the difference between  and  ? 

(Note: A bar indicates a digit pattern that is repeated.) 

A.            B.           C.              D.            E.  

Type  
 
 
 

 
Press ·. 
 
Use the Touchpad to click up and highlight the 
calculated answer. 

 
Press · to see more digits. 

 
 

http://www.actstudent.org/sampletest/math/math_03.html 

 

 

 

http://www.actstudent.org/sampletest/math/math_03.html
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Intermediate-Algebra - Zeros 
Finding roots of polynomials 

What is the intercept of the graph of  ? 

A.                  B.                C.                  D.                 E.  

Type the function,  into 
the entry line and press · to graph it. 
 
 

 
Press b>Trace>Graph Trace. Use the 
Touchpad to move to the right until it shows 
the minimum. 

 
Press · to lay down the ordered pair for the 
zero of the graph. 

 
 

http://www.actstudent.org/sampletest/math/math_04.html 

 

 

 

 

 

http://www.actstudent.org/sampletest/math/math_04.html
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Intermediate Algebra - Function Composition 
Composing functions 

If  and , then  ? 

F.                 G.                H.                 J.                  K.  

Type , then press /t (this types a :=). 
Then type the function, . Press ·. 
 
Type , then press /t (this types a :=). 
Then type the function, . Press ·. 
 
 

 
Type  and press ·. 

 
 

http://www.actstudent.org/sampletest/math/math_04.html 

 

 

 

 

 

 

 

 

 

 

http://www.actstudent.org/sampletest/math/math_04.html
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Pre-Algebra - Scientific Notation 
Calculations involving scientific notation 

A particly travels  meters per second in a straight line 

for  seconds. How many meters has it traveled? 

A.                      B.                         C.                              

                       D.                               E.  

Type , then type i followed by the 
exponent, .  
 
Type , then type i followed by the 
exponent, .  
              (Note: ) 
 

 
Press ·. 

 
 

http://www.analyzemath.com/practice_tests/act/act_sample_1.html 

 

 

 

 

 

 

 

http://www.analyzemath.com/practice_tests/act/act_sample_1.html
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Intermediate Algebra - Roots of Polynomials 
Finding roots of polynomials 

How many solutions are there to the equation  ? 

A.                   B.                    C.                     D.                 E.   

Unlike the Nsolve() command, the Polynomial 
Tools can produce multiple solutions. 
 
Press b>Algebra>Polynomial Tools>Find 
Roots of a Polynomial. 
Set the degree to  (default) and click OK. 
 

 
Enter the coefficients/constants for the given 
polynomial. 
 
Then click OK. 

 
Press ·. There are 2 solutions in the set. 
 
Note: CAS handhelds will produce the exact 

solutions of . 

 
Alternatively, a graph of the function shows 
that there are two intercepts (therefore 
two solutions). 
 

 
 

http://www.analyzemath.com/practice_tests/act/act_sample_1.html 

http://www.analyzemath.com/practice_tests/act/act_sample_1.html


22 
 

Coordinate Geometry - Equation of a Line 
Linear equations in two variables 

What is the equation of the line that contains the points with 

 coordinates  and  ? 

A.             B.        C.  

                   D.               E.  

Press b>Geometry>Points & Lines>Line.  
 
Hover over the icon in the top left corner of 
the screen and you will see the hint about 
pressing “(“ and then the coordinates to plot 
the segment. 

 
Press (, then enter the x-value, . Press 
·, then enter the y-value, .  
 
Repeat to enter the 2nd ordered pair. Press 
(, then enter the x-value, . Press ·, then 
enter the y-value, .  
 

 
Use the Touchpad to hover your cursor over 
the line and press /b>Coordinates & 
Equations. 

 
 

http://www.act.org/compass/sample/algebra.html 

 

 

http://www.act.org/compass/sample/algebra.html
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Pre-Algebra - Prime Numbers 
Determining prime numbers 

Which of the following lists gives the  largest prime numbers 

that are less than  ? 

A.  and               B.  and          C.  and  

                    D.  and                  E.  and  

TI-Nspire has a built in command for 
determining a prime number.  
 
Press k to access the catalog, then press I 
to jump to the commands that start with the 
letter i. Scroll down to the isPrime() command. 

 
Press · and type in the number, . Press 
· again to find out if it is prime. 
 
Use the Touchpad to click up and highlight the 
previous command. (Press · to paste the 
command onto the next line.) 

 
Use the isPrime() command to test more of the 
numbers. 
 

 
 

http://www.education.com/reference/article/posttest39/ 

 

 

http://www.education.com/reference/article/posttest39/
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Coordinate Geometry - f(y) Equations 
Relationship between points & lines 

In the  coordinate plane below, which of the following points has 

coordinates  such that  ? 

F. A 

G. B 

H. C 

J. D 

K. E 

Move your cursor to an empty space and press 
/b>Text.  Type,  and press 
·. 
 

 
Grab (/a) the equation text box and use 
the Touchpad to drag and drop it on the 

axis. 
 

 
Press b>Trace>Graph Trace. Type,  to 
substitute a value of . 
 

 
http://www.education.com/reference/article/posttest39/ 

http://www.education.com/reference/article/posttest39/
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Intermediate Algebra - Logarithms 
Evaluating logarithms with base other than 10 

Which of the following is a value that satisfies  ? 

A.                     B.                   C.                   D.                   E.  

Press t and choose the logarithm template. 
 

 
Type in the base and the number to take the 
log of, then press ·. 

 
http://www.education.com/reference/article/posttest39/ 

 

 

 

 

 

 

 

 

 

 

 

http://www.education.com/reference/article/posttest39/
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Coordinate Geometry - Distance 
Using the distance formula 

What is the distance, in coordinate units, between the points 

 and  in the standard  coordinate plane? 

A.               B.             C.               D.               E.  

Press b>Geometry>Points & 
Lines>Segment. 
 
Hover over the icon in the top left corner of 
the screen and you will see the hint about 
pressing “(“ and then the coordinates to plot 
the segment. 

 
Press (, then enter the x-value, . Press 
·, then enter the y-value, .  
 
Repeat to enter the 2nd ordered pair. Press 
(, then enter the x-value, . Press ·, then 
enter the y-value, .  
 

 
Use the Touchpad to hover your cursor over 
the segment and press 
/b>Measurement>Distance. 

 
 

http://www.education.com/reference/article/posttest39/ 

 

http://www.education.com/reference/article/posttest39/

